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1.0  Welcome to Sugar Open Source 

 
Thank you for using Sugar Open Source, created by SugarCRM Inc. The Sugar Open Source edition 
is designed to help you enable your organization to efficiently organize and maintain information 
which is crucial to many aspects of your business.  
 

• Sugar Open Source provides integrated management of corporate information on customer 
accounts and contacts, sales leads and opportunities, plus activities such as calls, meetings, 
and assigned tasks.  

 
• The system also offers a graphical Dashboard to track your sales pipeline, the most 

successful lead sources, and the month-by-month outcomes for opportunities in the pipeline. 
 
Most importantly, the system seamlessly blends all of these capabilities into an intuitive and friendly 
tabbed interface.The instructions in this guide will introduce you to some basic Customer 
Relationship Management (CRM) concepts and help you get familiar with the fundamentals of using 
your Sugar Open Source system.  
 
Sugar is an open source project, and as such, advances quickly through the development and 
contribution of new features by its entire supporting community, of which SugarCRM Inc., The Long 
Reach Corporation, and many other organizations and individuals are proud to be a part. Welcome to 
the community! 
 
  

1.1  About this Guide 
 
This guide is current with the details of operation for Sugar Open Source 2.5. It is designed for users 
who are new to the Sugar Open Source edition or the areas of customer relationship management 
and web-based applications generally. 
 
The information in this guide describes how to use a PC and a web browser to access Sugar Open 
Source in order to perform a broad range of corporate information management tasks.  
 
Readers are not required to have any programming or software development knowledge, but should 
be generally familiar with the use of a personal computer, and Internet browser software such as 
Microsoft Internet Explorer or Mozilla Firefox. 
 
  

1.2  Who Should Read this Guide? 
 
This Sugar Open Source User Guide provides information for two groups of system users – 
conventional users who wish to record and track company activities and outcomes; and 
administrators who manage user access to the system. 
 
This guide is not intended for system administration personnel who need to install and configure the 
system as part of its initial implementation. 
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2.0  About Sugar Open Source 

 
Sugar Open Source enables organizations to efficiently organize, populate, and maintain information 
on all aspects of their customer relationships. The system seamlessly blends all of the functionality 
required to manage information on many aspects of your business into an intuitive and friendly 
tabbed user interface. 
 
The core features of Sugar Open Source are – 

Customer Relationship Management:  
• Account creation and management, with any number of Contacts associated with each 

Account; 
• Activity history (Meetings, Calls, Tasks, Notes with optional file attachments, and Emails) is 

tracked for Contacts, Accounts, Leads, Opportunities and Cases;  
• Tasks may be assigned to users, and automatic email notifications may optionally be sent to 

advise users of new tasks; and 

Sales Force Automation:  
• Summary view of upcoming Appointments, top Opportunities, open Cases, Leads, open 

Tasks, assigned Bugs, sales pipeline graph, monthly calendar, and a quick contact entry 
facility; 

• Sales Lead creation and tracking, and conversion of sales Leads into Opportunities; and 
• Graphical Dashboard display of Opportunity Pipeline, Lead Sources & Outcomes. 

Customer Service Tracking:   
• A case management system that allows users to track customer problems and resolutions. 

Allows each problem to have a lifecycle of information to improve customer satisfaction; and 
• Each case links to the related Account, Contacts, Notes, associated files, plus Call and 

Meeting activity history. 
• A bug tracking system for managing bugs reported against different revisions of software. 

News Service:   
• An RSS news feeds module lets you select and manage your favorite news feeds, and 

display them on your My RSS News Feeds screen.  

Corporate Calendar:   
• Calendar view (by Day, Week, Month, or Year) of all corporate Activities, with an associated 

Task list; and 
• Shared calendar for viewing other user’s calendars for avoiding scheduling conflicts. 

Interface Consolidation:   
• The Portal module allows administrators and users to link external web sites and web 

applications into the Sugar Suite user interface, enabling Sugar Suite to become a unified 
information interface for its users.  

Sugar Open Source is built on established open-source technologies and widely supported industry 
standards, including the PHP development environment, the MySQL relational database, the Apache 
or IIS web servers, and the Linux or Windows Server operating systems. The system supports both 
the LAMP (Linux, Apache, MySQL, PHP) and WIMP (Windows, IIS, MySQL, PHP) platforms. 
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2.1  What’s New in this Version? 
 
With each revision of the Sugar Open Source software, significant advances are made in both the 
feature set and usability of the software. Here are some of the highlights of version 2.5 of the 
software, as compared to the previous version, 2.0.1, organized by the module involved. 

Home Module:  

• Each user can now modify the tab list. 
• My Upcoming Appointments  

� Now permits you to filter by today, tomorrow, this week, next week, this month 
and next month for greater flexibility in managing how you view your 
appointments.  

� Now displays all open appointments prior to the filter date, not just those open 
appointments between today and the filter date. This prevents you from 
forgetting previous open appointments.   

� The associated contact name and account name are now displayed when you 
mouse over the appointment name so that you don’t have to drill into each 
appointment to find this information.  

• My Open Cases and My Assigned Bugs have been added to the screen layout. 
• One of the best kept secrets in Sugar, the “Enter Business Card” shortcut has been 

added to the Shortcuts area.  This feature allows users to enter a new Contact, Account, 
Opportunity and follow-up Meeting all in one screen. 

Portal Module:  

• Add new tabs or individual user shortcuts to external web sites and applications.  Allows 
you to create a single enterprise application. 

Contacts Module:  

• Keep your data clean with a check for contact duplicates that now takes place when first 
creating a record – the same duplicate check that is performed when converting a lead 
or entering a business card.  

Accounts Module:   

• As with contacts, keep your data clean with a check for account duplicates that now 
takes place when first creating an account - the same duplicate check that is performed 
when converting a lead or entering a business card. If a possible duplicate is found, you 
are taken to a Show Duplicates screen.  

Activities Module:   

• When closing a task, meeting or call from the home tab, open activities sub-panel or 
activity list views, you are now taken to the edit view screen so that you can enter notes 
before saving.  Allows you to quickly enter notes about the activity as you close it. 

Dashboard: 

• A new charting engine that generates more attractive charts and supports Far East and 
Cyrillic character sets. This Flash-based plug-in is downloaded to the end user’s 
browser, allowing data to be populated as the user watches while simultaneously 
decreasing the server load.  
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RSS Module:   

• You can now receive and view news feeds (RSS and ATOM) in this new module. Each 
user can manage their own set of favorites to be displayed as My RSS News Feeds. 

Bug Tracker Module:  

• To enhance the service management capabilities of the system, a software bug tracking 
module has been added, to manage the life cycle of software bug reports.  

System Administration:  

• Customize fields in the application without directly modifying the source code.  Fields can 
be added, modified, removed or reconfigured through a simple point-and-click 
administration tool. 

• Modify dropdown values directly from the Admin screen. 
• New configuration settings have been added to the system configuration file which can 

disable the Export capability for all users, or for all users except those with Administrator 
capability.   

• You can now set your time and date display to new formats including day-month-year 
and 10:00am.  

• You can set your time zone and have all record time stamps displayed in your local time.  
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3.0  Getting Started with Sugar Open 
Source 

 

3.1  Before You Start 
 
This guide assumes that the resources you need to access the system are available and that you are 
familiar with how to use them. If you are not sure whether your system meets the requirements or 
how to use required third-party tools (primarily a web browser), talk to your manager or system 
administrator.  
 

3.11  Technical Requirements 
 
Before you begin using the system, ensure that you have the appropriate software installed and 
configured on your system. All you will need is – 
 

• A current web browser running on your computer. 

Sugar Open Source has been tested with and supports a variety of browsers.  The following 
browsers are known to work with Sugar Suite: 

o Mozilla version 1.7 and higher - www.mozilla.org/mozilla1.x 

o Firefox version 1.0 and higher - www.mozilla.org/firefox 

o Konqueror version 3.2 and higher - www.konqueror.org 

o Microsoft Internet Explorer version 5 and higher - www.microsoft.com/ie 

You may encounter problems if you try to access Sugar Open Source using older web 
browsers like Internet Explorer 4 or Netscape 4.x. If you are unsure about which web 
browser version you are using, click Help > About… or similar options on the menu bar in 
your browser. The version number will be displayed. 

• JavaScript and cookies support enabled in your web browser. 

Both JavaScript and cookies support must be enabled in the security settings of your 
browser and is usually turned on by default. 

If you encounter problems accessing the system, check your browser configuration to ensure 
both JavaScript support and cookies support are enabled. (See Tools > Internet Options > 
Privacy and Security tabs in Internet Explorer, or Tools > Options > Privacy and Web 
Features tabs in Firefox.) 

• Network access to a server that is running the Suga r Open Source software. 

Your system or network administrator will be able to provide you with an Internet address 
(URL) from which the system can be accessed.  
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Web Browser and Window Controls 

 
Sugar Open Source dynamically creates the HTML screens displayed by the web browser when you 
click certain buttons. 
 
Using ‘back’  and ‘forward’  buttons can cause problems displaying these dynamically generated 
pages. For this reason, we do not recommend using these controls on your browser when operating 
Sugar Open Source. 
 
Sugar Open Source is designed for a minimum 1024x768-pixel screen display resolution. 
 

Log In Information 

 
If you do not provide the correct user name and password, Sugar Open Source will not allow you 
access to the system. 
 
Your system administrator assigns log in information – a user name and password – to every system 
user. If you have not received your user name and password combination, contact your system 
administrator. 
 

3.2  Accessing Sugar Open Source  
 
To access Sugar Open Source, type the URL into your web browser’s address bar. You should see a 
screen similar to the one shown in Figure 1.  
 

 

Figure 1: The Sugar Open Source Log In Screen 
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This is the Sugar Open Source log in screen. If you do not see a log in screen, verify that you have 
entered the URL correctly. If you did not make a typing mistake, contact your system administrator to 
verify that you have the correct URL. 
 
To proceed, you must log in to the system by providing a valid user name and password.  
 
You may also choose the language that you want to use when working in the system, and the 
‘theme’ or visual appearance you want the system to have.  Languages and themes can be found at 
http://www.sugarcrm.com/home/Download_Sugar_Suite/107/. 
 

To log in to the System… 
 
In the Sugar Open Source log in screen –  

1. Type your user name in the User Name box. 

2. Type your password in the Password box. 

3. Select the language and theme that you want to use (if applicable). 

4. Click the Log In button. 

 

If you cannot log in…  
• Verify that your username and password were entered correctly, 

including any capital letters.  

• Contact your system administrator to verify that you have the 
correct username and password combination. 

• Your account may have been disabled. Contact your system administrator. 
 

3.2.1  Security Timeout 
 
For security reasons, the system will automatically log you out of the system if you do not perform 
any tasks for a period of time. By default, the system will not log you out until 30 minutes have 
elapsed without any activity. (This feature can be turned off, or the time period changed, via PHP 
configuration parameters.) 
 
When you are ready to resume working with the system, click any button on the screen. The system 
will automatically load the log in page for you. You can also close all web browser windows and re-
load the log in page manually. 
 

3.3  Managing Your Password 
 
When you are first given access to the system, your administrator will provide you with a password. 
For security reasons, you should change this password to another one that only you know. Ensure 
that you choose a password that is easy for you to remember, but difficult for another person to 
guess. 
 
You can change your password at any time. It is a good idea to change your password occasionally. 

Tip 

System passwords 
are case sensitive. 
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To change your password…  
1. Click the My Account link (see highlighted item 1, on Figure 2 

below) that appears at the top right of your screen whenever you 
are logged in to the system.    

2. On the My Account screen click on the Change Password button 
(see highlighted item 2, on Figure 2 below).  

3. In the Change Password dialog box which appears, type your new password in the New 
Password box, and again in the Confirm Password box. 

4. Click the Save button. 
 

If you forget your password…  
 
If you forget your password, you must contact your system administrator, who will reset it to a value 
which you can use temporarily. You should then log in to the system, and change the password to a 
value of your own choosing, according to the procedure described above.  
 

 

Figure 2: The ‘My Account’ Screen 

Tip 

System passwords 
must be at least 6 
characters long and 
contain at least 1 
numeric character. 

1 

2 
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3.4  The User Interface 
 
The first thing you will see after logging into the system is the Home tab, as shown below in Figure 3. 
Various key elements of the screen layout are highlighted on Figure 3, as follows: 
 

1. Navigation Tabs: Click to choose desired module 
2. Navigation Shortcuts Box: Specific shortcuts useful within each module  
3. Last Viewed: A remarkably handy trail of recent records you have viewed 
4. Search Box: Search for a text string within key data held by Sugar Open Source  
5. System Links: Admin link is only available to users marked as administrators 
6. Quick New Item Box: Quick data entry box to create a new item for the current module 
7. Main Screen Body: On the Home tab, this includes Cases, Opportunities, Appointments, 

Leads, Tasks, monthly Calendar, and a Pipeline graph.  
 

 
Figure 3: The Home Tab Screen 

 
The screen layout in the Home tab uses the same layout as all of the other tabs. What you will see 
as you move between the tabs, however, is that the shortcuts (2) change according to what would be 
useful within the specific tab, and the main screen body (7) displays the information indicated by the 
tab name. As well, the Quick New Item box (6) will vary in order to offer the creation of a new item of 
the type appropriate to the tab, for instance, New Contact, New Account, New Opportunity, and so 
on.  
 

1 

2 

3 
4 

5 

6 

7 
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3.4.1  Modules 
 
From the Home tab, you can access any Module with which you want 
to work, by clicking on the tab which bears its name. Modules help you 
work more efficiently by grouping the tools and functions you need to 
perform specific tasks. Sugar Open Source consists of twelve Modules:   
 

1. Home  

Contains a general overview of upcoming Appointments, top 
Opportunities, open Cases, Leads, open Tasks, assigned Bugs, sales pipeline graph, and 
monthly calendar. Also includes shortcuts to enter most sorts of data, and a quick form for 
new contacts. The Home tab provides a quick overview of what customer tasks and activities 
you need to focus on today. 

2. My Portal  

My Portal contains a series of shortcuts which can link to any website you choose. This is 
commonly used to include email, forums, or any other web-based application, allowing Sugar 
Open Source to become a single interface focus for its users.  

3. Calendar  

View scheduled activities (by day, week, month or year), such as meetings, tasks, and calls. 
Being able to share your calendar with your coworkers is a powerful tool for coordinating 
your daily activities. 

4. Activities  

Offers the ability to create or update scheduled activities, or to search for existing activities. 
By managing Activities within the context of an Account, Contact, Lead, Opportunity, or 
Case, the true value of Sugar Suite comes to light.  Sugar Suite allows you to manage the 
myriad of calls, meetings, notes, emails and tasks that you need to track in order to get your 
job done. 

• Tasks are for tracking any action that needs to be managed to completion by a due 
date. 

• Notes allow you to capture note information as well as upload file attachments. 

• Calls allow you to track all of your phone calls with leads and customers. 

• Meetings are like calls, but also allow you to track the location of the meeting. 

• Emails allow you to archive sent or received email messages.  If you use Microsoft 
Outlook, you can quickly archive email messages with SugarCRM’s Outlook Plug-In. 

5. Contacts  

View a paginated contact list, or search for a contact. You can click on a specific contact to 
zoom in on the detailed contact record. From a specific contact record, you may link to the 
related account, or leads, opportunities, cases, or direct reports (related contacts). 

Contacts are the people with whom your organization does business. As with accounts, 
Sugar Suite allows you to track a variety of contact information such as title, email address, 
and other data. Contacts are usually linked to an Account, although this is not required. 

6. Accounts  

View a paginated account list, or search for an account. You can click on a specific account 
to zoom in on the detailed account record. From a specific account record, you may link to 
related contacts, activities, leads, opportunities, cases, or member organizations. 

Tip 

Not every module has a 
screen tab.  For instance, the 
Notes, Emails, Tasks, Calls, 
and Meetings modules are 
all grouped together in the 
Activities tab. 
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Accounts are the companies with which your organization does business. Sugar Suite allows 
you to track a variety of information about an account including website, main address, 
number of employees and other data.  Business subsidiaries can be linked to parent 
businesses in order to show relationships between accounts. 

7. Leads  

View a paginated list of leads, or search for a specific lead. You can click on an individual 
lead to zoom in on the lead information record. From that detailed lead record, you can link 
to all related activities, and see the activity history for the lead. 

Leads are the people or companies with whom your organization might do business in the 
future. Designed to track that first point of interaction with a potential customer, leads are 
usually the hand off between the marketing department and the sales department. Not to be 
confused with a contact or account, leads can often contain incomplete or inaccurate 
information whereas contacts and accounts stored in Sugar Suite are core to many business 
processes that require accurate data. Leads are typically fed into the Sugar Suite system 
automatically from your website, trade show lists or other methods.  However, you can also 
directly enter leads into Sugar Suite manually. 

8. Opportunities  

View a paginated list of opportunities, or search for a specific opportunity. You can click on 
an individual opportunity to zoom in on the opportunity information record. From that detailed 
opportunity record, you can link to all related activities, see the activity history for the 
opportunity, and link to related leads and contacts.  

Opportunities track the process of selling a good or service to a potential customer. Once a 
selling process has commenced with a lead, a lead should be converted into a contact and 
possibly also an account. Opportunities help you manage your selling process by tracking 
attributes such as sales stages, probability of close, deal amount and other information. 

9. Cases  

View a paginated list of cases, or search for a specific case. You can click on an individual 
case to zoom in on the case information record. From that detailed case record, you can link 
to all related activities, see the activity history for the case, and link to related contacts. 

Cases are the handoff between the sales department and the customer support department.  
Cases help customer support representatives manage support problems or inquiries to 
completion by tracking information for each case such as its status and priority, the user 
assigned, as well as a full trail of all related open and completed activities. 

10. Bug Tracker  

View a paginated list of reported software bugs. You can click on an individual bug to zoom 
in on the detailed bug report. From that detailed bug report, you can link to all related 
activities, see the activity history for the bug, and link to related Contacts, Accounts, and 
Cases. 

Tracking software bugs is an important function of a customer support department.  The Bug 
Tracker module helps customer support representatives manage software-related support 
problems or inquiries to completion by tracking information for each bug such as its status 
and priority, its resolution, the user assigned, the release of software involved, its type 
(defect or feature) as well as a full trail of all related open and completed activities. 

11. RSS 

View the latest headlines provided by your favourite RDF Site Summary (RSS) feeds. These 
feeds provide news or other web content that is distributed or syndicated by web sites which 
publish their content in this manner. The system has hundreds of RSS feeds available as 
supplied, and others may easily be added.  
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Yahoo, ZDNet, Wired, Slashdot, Washing Post, The Telegraph, The Seattle Post, Reuters, 
New York Times, InfoWorld, Boston Globe, CBS MarketWatch, ABC News, BBC News – 
they’re all available to create your own custom news-gathering experience.  

12. Dashboard  

The Dashboard tab displays a graphical dashboard of your Opportunity Pipeline by Sales 
Stage, Opportunities by Lead Source by Outcome, Pipeline by Month by Outcome, and 
Opportunities by Lead Source.  

 

To select a Module…  
 
From the Home tab –  

• Click on the tab which shows the name of the Module you wish to 
use. 

 

3.4.2  Navigating the Module Screens 
 
All of the Task Module screens use the same basic layout – making it easy for you to move from one 
area of the application to the next. Figure 3 shows the Sugar Open Source screen with the Home tab 
as the selected Task Module.  
 

3.4.3  List View Screens and Searching 
 
Most Module screens (Home, Calendar, and Dashboard are the exceptions) have two key elements 
to them – a search filter capability at the top, and a list view of items below. As an example, look 
ahead to Figure 10, the Accounts Module. Generally, the search filter has basic search fields, and a 
link to use the advanced search with more fields on which to filter the list of items below. You can see 
this Advanced link on Figure 10, on the right hand side of the Account Search area. 
 
When working with the list view, you can work with the complete list, or use the search filter to reduce 
it to a more manageable size. To use the search filter, simply type in one or more boxes, and click on 
the Go button. Text entered in search fields needs to match from the beginning of the value stored in 
each record – for example “fred” will match Frederick, but not Alfred, in a first name field. If text is 
entered in more than one search field, then a record must match on all those fields to be included in 
the filtered list. Wild card search characters are therefore not needed and consequently not 
supported.  In other words, searching for “fred*” would only match first names like “Fred*erick” or 
other “Fred” names containing the asterisk (*) character. 
  
Using the system level search box (highlighted item 4 on Figure 3 above) is much the same, only it 
searches Contacts, Accounts, Leads, Opportunities and Cases, and looks for search text to match 
from the beginning of key fields for each, as below (Note: numeric search strings will match 
anywhere in a field). Then all matching records are displayed in a series of paginated lists.  

Contacts:  First Name, Last Name, Email, Other Email, Home (phone), Mobile (phone), Office 
Phone, Other Phone, Fax, Assistant, Assistant Phone  

Accounts:  Account Name, Phone, Other Phone, Fax 

Leads:  First Name, Last Name, Account Name, Email, Other Email, Home (phone), Mobile (phone), 
Office Phone, Other Phone, Fax 

Tip 

The Module tab list is 
always available at the 
top of the browser 
window. Click one of 
the tabs in this list to 
switch modules. 
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Opportunities:  Opportunity Name 

Cases:  Case Number, Subject 
 

 

3.4.4  Detail View Screens 
 
From a module’s list view, clicking on any entry in the list will bring up the detail view for that item – 
for example the full details of a contact, or an account. This detail view shows more information than 
the list view for the specific item selected. It also shows all associated items of information, and lets 
you click on links to them. For example, the Accounts detail view screen lists all associated Account 
Open Activities, History (Notes, Emails, Tasks, Meetings, and Calls), Contacts, Opportunities, Leads, 
Cases, Member Organizations and Bugs. These lists of related information are called sub-panels. 
 
This listing of associated items as sub-panels is really the fundamental power of the Sugar Open 
Source system – the system associates and represents information in much the same way that your 
brain thinks, and lets you navigate or explore the information that way. Figure 4 below shows a 
sample detail view screen with the Open Activities, History, Contacts, Opportunities, Leads, Cases, 
Member Organizations and Bug Tracker sub-panels.  
 

 

3.5  Logging Out of the System 
 
When you are finished working with the system, you should always log out of the system rather than 
just closing your web browser. 
 
When a user logs out, the system performs several ‘clean-up’ procedures, and then automatically 
returns the web browser window to the Login screen.  
 

To log out…  
1. Click the Logout link in the User Management area (see item 5, Figure 3), in the top right 

hand area of the screen. 

2. If desired, you may now close the browser window. 
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Figure 4: The Account Detail Screen 
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4.0  Using Sugar Open Source 

 

4.1  The Portal Module 
 
Figure 5 shows the Sugar Open Source screen with the Portal Module selected using the My Portal 
navigation tab:  
 

 
Figure 5: The My Portal Module 

 
The My Portal screen offers shortcuts to any web site or application you as the end-user choose. 
Administrators can also add shortcuts to the list in My Portal as well as create entirely new Portal 
tabs.  New tabs are commonly used to include email, forums, or any other web-based application, 
allowing Sugar Open Source to become a single interface focus for its users. The initial web site 
displayed when you enter the screen is the Portal home site (a configuration option set by your 
Administrator).  
 
All users have a set of shortcuts allowing them to Add Site, List Sites, or navigate to any site visible 
to them. Each user has shortcuts to all Global sites created by the Administrator, plus any Personal 
sites they have created. 
 
The Portal List screen may be reached by clicking on the List Sites shortcut. From the Portal List 
screen, you can delete one or more Portal sites by selecting the checkbox beside them, and clicking 
on the Delete button below the list of Portal sites. You can also edit a Portal site by clicking on its 
name, or preview its target website by clicking on the link to its URL.  
 
You can create a new Portal site by clicking on the Add Site shortcut. When creating a new Portal 
site, you may enter the name and website for the new Portal site, click to select if it is currently visible 
or not, and choose if it is Personal (viewable only by you), or Global (viewable by everyone). Note: 
Only Administrators have the option to create Global Portal sites.  
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4.2  The Calendar Module 
 
Figure 6 shows the Sugar Open Source screen with the Calendar Module selected using the 
Calendar navigation tab:  
 

 
Figure 6: The Calendar Module (Month Format) 

 
The calendar has four optional display formats – Day, Week, Month and Year, which may be 
selected by clicking on the appropriate button at the top left of the main screen body. Month format is 
shown in Figure 6 above, and Day format in Figure 7 below. In each format, any planned activities 
with associated dates are automatically displayed – such as Calls, Meetings, Tasks, Notes and 
Emails. Icons are used to indicate the type of activity:  for a Call,  for a Task, and  for a 
Meeting. You may click on any activity which is displayed, in order to edit that activity.  
 
Each different display format allows you to nudge backwards and forwards in time - by a day, week, 
month or year as appropriate. In the Week, Month or Year display formats, clicking on a particular 
date within the display will shift the display to Day format for that date.  
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Figure 7: The Calendar Module (Day Format) 

 
The Day display format has the hours of the day listed vertically, and clicking on a specific time 
brings up a quick method of scheduling a Call or Meeting, as shown in Figure 7 above.  
 
The Day display format also includes a task list on the right side of the main screen body. You may 
click on the subject of any task in the list to view the details of that task.   
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4.3  The Activities Module 
 
Figure 8 shows the Sugar Open Source screen with the Activities Module selected using the 
Activities navigation tab:  
 

 
Figure 8: The Activities Module (Task List View) 

 
The Activities module allows you to create a new Call, Meeting, Task, Note or Email, by using 
shortcuts in the navigation shortcuts box. As well, you may select five different list views, for Calls, 
Meetings, Tasks, Notes or Emails, again via the navigation shortcuts box. Figure 8 illustrates the 
Task List view mode. Each of the list views typically provides  Print and  Help icons on the title 
bar at the top of the main screen body, followed by a search capability, and then a list of all or 
selected (by the search) items. Each item in the list has a check box at the left, and at the bottom of 
the screen is a facility to update one or more field values for all checked items.  
 
Each list may be sorted by clicking on any column title which has the  icon beside it. Clicking on a 
column title when it is already the highlighted sort column reverses the sort order. 
 
Each list is paginated if it contains more items than may be listed on the display, and controls are 
provided to go to the start or end of the list, or step to the next or previous page.   
 
Each of these list views provides powerful linking capabilities to related information. The Task List 
view, for example, lists Subject, Contact, Related To, Due Date, and the user assigned to the task. 
Clicking on a task’s subject takes you to a detailed view of the specific task. Clicking on the Contact 
zooms to a detailed view of that contact, and so on. This is the real power and elegance of the Sugar 
Open Source user interface. 
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4.4  The Contacts Module 
 
Figure 9 shows the Sugar Open Source screen with the Contacts Module selected using the 
Contacts navigation tab:  
 

 
Figure 9: The Contacts Module 

 
The Contacts module provides  Print and  Help icons on the title bar at the top of the main 
screen body, followed by a search capability, and a list of all or selected (by the search) Contacts. 
Each Contact in the list has a check box at the left, and at the bottom of the screen is a facility to 
update one or more field values for all selected Contacts. 
 
The Contact list may be sorted by clicking on any column title which has the  icon beside it. Clicking 
on a column title when it is already the highlighted sort column reverses the sort order. 
 
The Contact list is paginated if it contains more items than may be listed on the display, and controls 
are provided to go to the start or end of the list, or step to the next or previous page. Clicking on any 
Contact in the list displays the detail information for that Contact. 
 
The navigation shortcuts provided will help you create a new contact (by typing it in or by importing 
the information from a vCard), or switch back to the Contact List view. As well, an Import facility is 
provided, to import bulk contact data from Salesforce.com, Outlook, ACT!, etc… 
 
The Contact list view provides powerful linking capabilities to related information. Clicking on the 
Contact name takes you to a detailed view of that Contact. Clicking on the Account name zooms to a 
detailed view of that Account.  
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4.5  The Accounts Module 
 
Figure 10 shows the Sugar Open Source screen with the Accounts Module selected using the 
Accounts navigation tab:  
 

 
Figure 10: The Accounts Module 

 
The Accounts module provides  Print and  Help icons on the title bar at the top of the main 
screen body, followed by a search capability, and then a list of all or selected (by the search) 
Accounts. Each account in the list has a check box at the left, and at the bottom of the screen is a 
facility to update one or more field values for all selected accounts. 
 
The Account list may be sorted by clicking on any column title which has the  icon beside it. Clicking 
on a column title when it is already the highlighted sort column reverses the sort order. 
 
The Account list is paginated if it contains more items than may be listed on the display. Controls are 
provided to go to the start or end of the list, or step to the next or previous page. Clicking on any 
account in the list displays the detail information for that account. 
 
The navigation shortcuts provided will help you create a new account, or switch back to the Account 
List view. As well, an Import facility is provided, to import bulk account data from Salesforce.com, 
ACT!, etc… 
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4.6  The Leads Module 
 
Figure 11 shows the Sugar Open Source screen with the Leads Module selected using the Leads 
navigation tab:  

 
Figure 11: The Leads Module 

 
Leads are early contacts in the sales process. Once they have been properly evaluated and 
assessed, they may be converted into Contacts, with associated Opportunities and Accounts. 
 
They may be managed and tracked through their life-cycle using the Leads module. Leads may be 
assigned a Lead Source of Cold Call, Existing Customer, Self Generated, Employee, Partner, Public 
Relations, Direct Mail, Conference, Trade Show, Web Site, Word of Mouth, or Other. They have a 
status of New, Assigned, In Process, Converted, Recycled, or Dead.  
 
Leads may be duplicated (by clicking on the Duplicate button) as a handy way of creating a number 
of similar leads. Leads may also be converted (by clicking on the Convert Lead button) to Contacts, 
and optionally their related Account, Opportunity, and even Appointment. 
 
The Leads module provides  Print and  Help icons on the title bar at the top of the main screen 
body, followed by a search capability, and a list of all or selected (by the search) Leads. The Leads 
list may be sorted by clicking on any column title which has the  icon beside it. Clicking on a column 
title when it is already the highlighted sort column reverses the sort order. Each lead in the list has a 
check box at the left, and at the bottom of the screen is a facility to update one or more field values 
for all selected leads. 
 
The Leads list is paginated if it contains more items than may be listed on the display, and controls 
are provided to go to the start or end of the list, or step to the next or previous page. Clicking on any 
lead in the list displays the detail information for that lead. 
 
The navigation shortcuts provided will help you create a new lead (from a vCard, or by simply typing 
it in), or switch back to the Leads list view. As well, an Import facility is provided, to bring in bulk lead 
data from Salesforce.com, etc… 
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4.7  The Opportunities Module 
 
Figure 12 shows the Sugar Open Source screen with the Opportunities Module selected using the 
Opportunities navigation tab:  
 

 
Figure 12: The Opportunities Module 

 
The Opportunities module provides  Print and  Help icons on the title bar at the top of the main 
screen body, followed by a search capability, and a list of all or selected (by the search) 
Opportunities. The Opportunities list may be sorted by clicking on any column title which has the  
icon beside it. Clicking on a column title when it is already the highlighted sort column reverses the 
sort order. Each opportunity in the list has a check box at the left, and at the bottom of the screen is a 
facility to update one or more field values for all selected opportunities. 

 
The Opportunities list is paginated if it contains more items than may be listed on the display, and 
controls are provided to go to the start or end of the list, or step to the next or previous page. Clicking 
on any opportunity in the list displays the detail information for that opportunity. Clicking on the 
account name for an opportunity links to the detailed information for that account. 
 
The navigation shortcuts provided will help you create a new opportunity, or switch back to the 
Opportunity list view. As well, an Import facility is provided, to bring in bulk opportunity data from 
Salesforce.com, etc… 
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4.8 The Cases Module 
 
Figure 17 shows the Sugar Open Source screen with the Cases Module selected using the Cases 
navigation tab:  
 

 
Figure 13: The Cases Module 

 
Cases are inquiries or problems associated with an account. They may be managed and tracked 
through their life-cycle using the Cases module. Cases may be assigned High, Medium or Low 
priority. They have a status of New, Pending Input, Assigned, Rejected, or Closed.  
 
The Cases module provides  Print and  Help icons on the title bar at the top of the main screen 
body, followed by a search capability, and a list of all or selected (by the search) Cases. Each Case 
in the list has a check box at the left, and at the bottom of the screen is a facility to update one or 
more field values for all selected Cases. 
 
The Cases list may be sorted by clicking on any column title which has the  icon beside it. Clicking 
on a column title when it is already the highlighted sort column reverses the sort order. 
 
The Cases list is paginated if it contains more items than may be listed on the display, and controls 
are provided to go to the start or end of the list, or step to the next or previous page. Clicking on the 
subject for any case in the list displays the detail information for that case. Clicking on the account 
name for a case links to the detailed information for that account. 
 
The navigation shortcuts provided will help you create a new case, or switch back to the Case list 
view.   
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4.9 The Bug Tracker Module 
 
Figure 18 shows the Sugar Open Source screen with the Bug Tracker Module selected using the 
Bug Tracker navigation tab:  
 

 
Figure 14: The Bug Tracker Module 

 
Bugs are defects or features associated with a particular revision of a software product. They may be 
managed and tracked through their life-cycle using the Bug Tracker module. Bugs may be assigned 
a priority of Urgent, High, Medium and Low. They have a status of New, Assigned, Closed, Pending 
Input, or Rejected. Each Bug also specifies a release. The drop-down list of choices for release is 
populated by the System Administrator using the Issue Tracker Administration option within the 
administration screens. Each Bug may also be assigned a resolution status of Accepted, Duplicate, 
Fixed, Out of Date, Invalid, or Later.   
 
The Bug Tracker module provides  Print and  Help icons on the title bar at the top of the main 
screen body, followed by a search capability, and a list of all or selected (by the search) Bugs. Each 
Bug in the list has a check box at the left, and at the bottom of the screen is a facility to update one or 
more field values for all selected Bugs. 
 
The Bug list may be sorted by clicking on any column title which has the  icon beside it. Clicking on 
a column title when it is already the highlighted sort column reverses the sort order. 
 
The Bug list is paginated if it contains more items than may be listed on the display and controls are 
provided to go to the start or end of the list, or step to the next or previous page. Clicking on the 
subject for any Bug in the list displays the detail information for that Bug.  
 
The navigation shortcuts provided will help you create a new Bug report, or switch back to the Bug 
list view. There is also a New Bug data entry box for quickly entering a new Bug as it is reported.  
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4.10 The RSS Module 
 
Figure 19 shows the Sugar Open Source screen with the RSS Module selected using the RSS 
navigation tab:  

 
Figure 15: The ‘My RSS News Feeds’ Screen 

 
The RSS Module manages RDF Site Summary (RSS) feeds. These feeds provide news or other web 
content that is syndicated by web sites which publish their content in this manner. Sugar Open 
Source has hundreds of RSS feeds available as it is supplied, and others may easily be added via 
the New RSS Feed data entry box to create your own custom news-gathering experience. Clicking 
on the RSS Tab brings up the My RSS News Feeds screen, as shown in the figure above. This 
screen is assembled from all the feeds you have marked as your favourites, and shows the latest 
information being provided by those feeds. The shortcuts provided let you display the All RSS News 
Feeds screen, or return to the My RSS News Feeds screen. 
 
Each feed on the My RRS News Feeds screen has , , and  controls to the right side of their 
header bar, to promote (move higher within the list), demote (move lower in the list), or remove that 
feed from your list of favourites. Within the header bar for each feed, you can also click on the name 
of the feed to see a full list of the items of information available from that feed, or on the word 
Website to go to the website associated with that feed. Each item of information listed for a feed has 
a brief title for the item which is linked to the full story or content, and the time and date when that 
item was added to the feed. Simply click on an item to see the full content in a new browser window.  
 
The RSS module provides the usual  Print and  Help icons on the title bar at the top of the main 
screen body. On the All RSS News Feeds screen, this is followed by a search capability, and a list of 
all or selected (by the search) RSS News Feeds. The RSS News Feeds list is paginated if it contains 
more items than may be listed on the display and controls are provided to go to the start or end of the 
list, or step to the next or previous page. Clicking on the Title for any RSS News Feed in the list 
displays the full set of information currently available from that feed. Each RSS News Feed also has 
a control to add or remove it from your list of favourites. 
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4.11 The Dashboard Module 
 
Figure 20 shows the Sugar Open Source screen with the Dashboard Module selected using the 
Dashboard navigation tab:  
 

 
Figure 16: The Dashboard Module 
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There are four charts on the Dashboard display, as shown in Figure 20 above. Highlighted item 1 on 
Figure 20 above is a horizontal stacked bar chart of Pipeline by Sales Stage. Each bar shows the 
value of potential sales at each stage of the sales pipeline.   
 
Highlighted item 2 on Figure 20 above is a horizontal stacked bar chart of Opportunities by Lead 
Source by Outcome. It shows a stacked bar of the total opportunities for each lead source. Each bar 
is made up of multi-coloured segments which represent the outcome proportions for that lead source.  
 
Highlighted item 3 on Figure 20 above is a stacked bar chart of Pipeline by Month by Outcome. Each 
bar shows the total sales pipeline for each month. Each bar is made up of multi-coloured segments 
which represent the outcome proportions for the pipeline in that month. 
 
Highlighted item 4 on Figure 20 above is a pie chart of Opportunities by Lead Source. This shows a 
simple pie visualization of the proportion of total sales opportunities for each lead source. 
 
Each chart may be customized by clicking on the Edit button by the top right corner of the chart. This 
will bring up a small dialog area which permits you to specify parameters of the report, including (as 
appropriate): 
 

• The date range or year for data to be charted; 
• The user or users for whom data should be charted;  
• The Sales Stages to be charted; and 
• The Lead Sources to be charted. 

 
The dialog box for each chart may be closed by clicking on the Edit button again, or you may alter 
parameters and then click on the Select button to produce a chart from different data. You may right 
click on each chart to set its display quality, to zoom the image, or to print it (charts are produced 
using Flash technology). To copy a chart for inclusion in a document (as in the figure below) you will 
need to take a screen copy (such as by using Alt-Print Screen in Windows) and then crop the 
captured image in an image editor such as Photoshop.  
 

 
Figure 17: The 'Sales Pipeline by Sales Stage' Char t 

 
A remarkably powerful feature of the Dashboard is that the charts allow for drilling down into the 
actual underlying data. This means that each distinctively coloured area on every chart is actively 
linked to the set of opportunities it represents – simply click on an area to see those opportunities. 
Each chart is somewhat laborious to produce, and so their data sources are not automatically 
recalculated each time the Dashboard is displayed. To recalculate the data source for a given chart, 
simply click on the Refresh button associated with it (beside the Edit button). 
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5.0  User Profiles and System Admin  

 

5.1  My Account 
 
To enter your own user profile screen, click the My Account link (see highlighted item 1, on Figure 24 
below) that appears at the top right of your screen whenever you are logged in to the system. Note 
that the Admin link just next to it is only displayed for users with Administrator capability. Figure 24 
below shows the user profile screen. The highlighted item 2 shows a Duplicate button, which is also 
only present for users with Administrator capability. It allows an administrator to duplicate an account 
record (and then edit it briefly) as a quick way of creating a new user.  
 
As discussed in the section on Managing Your Password, the Change Password button should be 
used periodically by each user of the system to change their user password.  
 

 
Figure 18: The 'My Account' Screen 
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To edit the user profile, and change user preferences, click on the Edit button. This brings up a 
screen which lets you define header information (such as First and Last Name, User Status, and 
User Name), User Settings, Edit Tabs, User Information (email address, title, department, and phone 
numbers), and Address Information. These five groups of information are known collectively as the 
user profile.  
 
User settings include such items as a check box for Administrator capability (only users with 
Administrator capability are able to check this off), Assignment notifications (do you receive an email 
when you are assigned a responsibility), time format (AM/PM or 24-hour clock), a check box for 
gridlines on screen displays, and a selector for the default preferred Currency.  
 
Using Edit Tabs, users can also modify what tabs they see when logged in.  Administrators define 
the master list of available tabs in the administration screens, but users can then modify their own tab 
list by removing any unneeded tabs. 
 
User Information, and Address Information round out the user profile. User Information contains a 
user’s contact information, title, department name, and supervisor’s name. Address information 
typically contains the user’s home address.   
 
 

5.2  System Administration 
 
Administrators of the Sugar Open Source system perform their functions via the System 
Administration screen, which is reached by clicking on the Admin link (see highlighted item 1, on 
Figure 25 below). Note that the Admin link is only displayed for users with Administrator capability 
 

 
Figure 19: System Administration Module 

 
The System Administration area offers four options:  
 

• Configure Settings;  
• Upgrade; 
• User Management; and 

1 
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• Currencies. 
 
The Sugar Studio area also offers four options:  
 

• Field Layout;  
• Dropdown Editor; 
• Portal; and 
• Configure Tabs. 

 
Lastly, the Bug Tracker area offers an option to maintain the names of software releases.  
 

5.2.1  System: Configure System Settings 
Sugar Open Source can send users an email notification when they are assigned new 
responsibilities. Within the system administration functions, Configure Settings is used to enable, 
disable or configure the email notification system.  
 
Email notification settings include the subject line of the email to be sent, the user name and email 
address from which the email will be sent, as well as the Mail Transfer Agent (MTA) to be used. Note 
that the SMTP (Simple Mail Transfer Protocol) MTA should be selected if your system is running 
Windows. If your system is running Linux, either the SMTP or sendmail MTA may be selected, 
depending upon how your server is configured.  
 
If the SMTP MTA is selected, you must also specify the SMTP server name, and port number 
(default is 25) used to communicate with SMTP. If SMTP Authentication is selected via the checkbox 
provided, the SMTP User Name and Password to be used must also be provided.   
 
Configure Settings can also enable and disable the email notification system, and establishes the 
default notification setting for new users.   
 

5.2.2  System: Upgrade 
Upgrade is a system administration function which offers a selection of database upgrade options to 
convert and update data from a previous revision of Sugar Open Source into the right form for use 
with the current version of the program. The upgrade options listed are: 
 

• Upgrade Opportunities: Controls the manner in which currency fields within Opportunities are 
upgraded. This is needed as newer versions of Sugar Suite support an internationalized 
currency capability, which stores the currency type separately from the amount. This section 
is only relevant when upgrading from a pre-2.5 release of Sugar Open Source; 

Upgrade Opportunities has several activity buttons within it, as follows: 
 

• Verify Amounts: Clicking on this button verifies that the values in the currency fields are valid 
(i.e., numeric only), and do not have any currency characters (e.g., US, CDN) in the value 
portion of the field. Checking Include Closed Records will also verify the currency fields of all 
closed records; 

• Fix Amounts: Attempts to fix any invalid amounts as detected above by creating a valid 
decimal value from the current amount. This procedure will backup any amounts it modifies 
into a database field called amount_backup. Warning : If you perform this function and notice 
errors, do not perform it again without first restoring from the backup (via Restore Amounts, 
below) as it will most likely overwrite the backup with new invalid data. Checking Include 
Closed Records will also fix the currency fields of all closed records; 
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• Merge Currencies: Merges multiple currencies into a single currency. If you notice that there 
are multiple currency records for the same currency, you may choose to merge them 
together. This will also merge the currencies for all other modules. For example, “US” and 
“U.S.” would be merged to a single currency;  

• Update US Dollar Amounts: Updates the U.S. Dollar amounts for Opportunities based on the 
current currency rates. This value is used to calculate Graphs and List View currency 
amounts. This will apply the exchange rates stored in the Sugar Suite system and modify all 
the US currency field values based upon the current rates. Checking Include Closed Records 
will also update the US dollar amounts of all closed records; and 

• Restore Amounts: This will undo the Fix Amounts processing, by restoring the original value 
from the backup field. 

 

5.2.3  System: Currencies 
The Currencies screen is used to define currencies other than the US dollar. For each new currency 
defined, the name, symbol (e.g. $), exchange rate to the US$, and code (such as CDN for the 
Canadian dollar) must be entered. Note that each User can select his default currency in the User 
Management screen. 
 

5.2.4  System: User Management 
User Management is used to create, remove, edit, and activate/deactivate users of the Sugar Open 
Source system. The User Management screen is shown as Figure 26 below.  
 
On this screen, an Administrator can search for a user, or simply click on a user name to select their 
profile to edit. Once a user profile has been selected, the Administrator may change the password, 
edit the profile, or duplicate the profile, using the methods described in the My Account section. Note 
that Users must have a valid email address in order to receive email notifications.  
 

  
Figure 20: The User Management Screen 
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5.2.5 Studio: Field Layout 
The Layout Editor lets you rearrange the fields and panels on most of the screens available within 
Sugar Open Source, to customize them to fit your needs.  
 
Begin by selecting the name of the file (actually a specific view from one of the system’s modules, 
either the list view, detail view, or edit view) you want to customize. Choose the file name from the 
drop-down box provided, and then click on the Select File button. If you’re not sure what file to edit 
you can select the Edit in Place checkbox; this will add an edit icon  to all the editable screens 
throughout Sugar Open Source. Now go to the screen you want to edit, click on the  icon, and you 
will enter the screen layout editor to customize that screen layout.  
 
Within the field layout function, there are three very special shortcuts available in the Shortcuts Box 
(not all are available at all times):  

• Select File : Sends you to the screen first seen when entering the field layout function, to 
select a file to edit. If you select this shortcut when you are in the middle of editing a screen, 
edits on that screen are lost if not already saved.   

• Edit Fields : Within the Layout Editor, Edit Fields is a mode that let’s you drag and rearrange 
individual fields or their labels within the details panel. Select the item handle (the little 
square grey box) next to the field or label you want to move, and then click on the item 
handle where you want the field or label located. This will move the item from its previous 
location to its new location. If there was already a field or label at the destination the two 
items will swap positions. Edit Fields also let’s you move sub-panels. Moving sub-panels is 
the same as moving fields; select the source sub-panel handle and then click on the 
destination sub-panel handle, and the two will switch locations.  

• Edit Rows : Within the Layout Editor, Edit Rows is a mode that allows the addition and 
removal of rows in the details panel. Pressing the  adds a row below the one currently 
selected, and pressing the  removes the row currently selected. 

 
The Toolbox provides a workspace to add new fields and labels to a screen, to temporarily hold 
items that have been removed from a screen, and to discard items which are not needed. Its 
functions include: 

• Add Field : Opens a dialog box which lets you specify the type of field you want to add and 
its name label. Click on the Add button to put your new field and its label in the Toolbox 
workspace, and close the dialog box. Next, to move your new field from the Toolbox to the 
screen, select its item handle and then click on the item handle where you want the field 
located. 

• Display HTML Code : To test this feature, select this checkbox and then move your cursor 
around the screen being edited. As the cursor passes over each field or label in the screen 
you will see the html that comprises it displayed as ‘Alt’ text in a floating box below the 
cursor. Note:   While this function can be informative it is very CPU intensive, and should only 
be used when absolutely necessary. 

• Removing an item is accomplished by selecting its handle and dragging it to the Drag 
Unwanted Items Here area within the Toolbox. This will deposit the selected item in the 
Toolbox workspace. 

 
Use the Save Layout button to save changes while in the Layout Editor. To discard changes simply 
choose the Select File shortcut to work on another file, or exit the Layout Editor entirely. Remember 
to un-check the Edit in Place checkbox before you leave the field layout function, or all your screens 
will still have the  icon on them. 
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5.2.6 Studio: Dropdown Editor 
The Dropdown Editor is a very valuable tool for the Administrator. It permits the values in all of the 
drop-down boxes in the system to edited. The options presented to the user may be edited, existing 
options may be eliminated, and new options may be added. For example, when defining a new 
Account, in the Account Type field, the user must normally choose from a set of drop-down options, 
including Analyst, Competitor, Customer, Integrator, Investor, Partner, Press, Prospect, Reseller, and 
Other. By using the Dropdown Editor, this option set may be altered, with more or less options, and 
different option values.  
 
To use the Dropdown Editor, select a name of a drop-down list, from the drop-down list of their 
names (if that is not too confusing a statement!). For example, account_type_dom is the second 
option on this list. If you select that option, and then choose the language US English (only those 
language packs which have been installed on your system will be available as choices), and click on 
the Select button, you will see a list of the Account Type options as given above.  
 
On each line of the list, you will see a number of controls on the right hand side. The up and down 
arrows controls allow you to promote or demote an option, to a higher or lower position on the list. 
The Edit and Del controls allow you to edit or delete the drop-down options, respectively. The Ins 
control will add a new drop-down option into the list above the item on the line you click on. 
 

5.2.7 Studio: Portal 
The Portal Administrative function is used to add new Tabs and Shortcuts to Sugar Open Source, 
which can link to any website you choose. This is commonly used to include email, forums, or any 
other web-based application, allowing Sugar Open Source to become a single interface focus for its 
users.   
 
Using this administrative option performs a similar function to clicking on the Portal tab to select the 
Portal module, and indeed takes you to the Portal module. However note that an Administrator will 
initially see the Portal List screen, but other users will see the Portal home site (a configuration 
option).  
 
All users have a set of shortcuts allowing them to Add Site, List Sites, or navigate to any site visible 
to them. Each user has shortcuts to all sites marked as Global sites, plus any Personal sites they 
have created. 
 
The Portal List screen may be reached by clicking on the List Sites shortcut. For an Administrator, 
this screen lists all sites - Global sites available to all users, as well all the Personal sites created by 
individual users for their own specific purposes. If you are not an Administrator, you will not see the 
Global sites listed on this screen, as you do not have the ability to change any of them.  
 
From the Portal List screen, you can delete one or more Portal sites by selecting the checkbox 
beside them, and clicking on the Delete button below the list of Portal sites. You can also edit a 
Portal site by clicking on its name, or preview its target website by clicking on the link to its URL.  
 
You can create a new Portal site by clicking on the Add Site shortcut. When creating a new Portal 
site, you may enter the name and website for the new Portal site, click to select if it is currently visible 
or not, and choose if it is Personal (viewable only by you), or Global (viewable by everyone). Note: 
Only Administrators have the option to create Global Portal sites. You may also choose to have the 
new Portal site placed on a new Tab, on a new Shortcut, or both. Note: Only Administrators have the 
option to place a site on a Tab – other users may only create shortcuts. On any new Tab created by 
the Portal function, the Shortcuts Box contains all the same shortcuts as are provided on the Portal 
Tab.  
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5.2.8 Studio:  Configure Tabs 
Both system administrators and users can easily configure which tabs appear at the top of the 
application.  In the Configure Tabs administration option, administrators can define which menu tabs 
will appear for all users.   
 
Users can then modify their own personal tab settings in the My Account screen.  Any tabs that an 
administrator removes cannot be added back by a user. 
 

5.2.9 Bug Tracker: Releases 
The Releases Administration function is used to maintain the set of options available as selections on 
the Release drop-down box offered to users when reporting a new bug in the Bug Tracker module.  
 
Each Release entry consists of a release version, a status (Active or Inactive, where Inactive will 
remove it from drop down lists) and the order in which it is to appear in the Release drop down list. 
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6.0  Information Import and Export  

 
One of the most important aspects of any CRM software is getting the data from your last CRM 
system moved across into the new one, and getting the data out of your new CRM system for use in 
other applications. Note that this should typically only be done by a system Administrator.  
 
Sugar Open Source supports the importation of various kinds of data from several different popular 
contact managers and full CRM systems: 

• Accounts may be imported from Salesforce.com, from ACT!, or from most other systems via 
a custom mapping;  

• Contacts may be imported from Salesforce.com, from ACT!, from Outlook, or from most 
other systems via a custom mapping;  

• Leads may be imported from Salesforce.com, or from  most other systems via a custom 
mapping; and  

• Opportunities may be imported from Salesforce.com, or from most other systems via a 
custom mapping. 

 
 

6.1  Importing Accounts & Contacts 
 
Importing Contacts into Sugar Open Source is fairly straightforward. First you use your old CRM 
application or contact manager to export the data into a Comma Separated Values (.CSV) file format. 
Then you use the import function within the Contacts module (accessible via the Navigation 
Shortcuts Box) to import the data. If a Contact record is imported which refers to an unknown 
Account, then a new record is automatically created for an Account of that name.  
 
One thing to watch, however, is that when Account records are created automatically in this fashion, 
they are essentially empty – they have associated contacts, but no address or telephone information 
is recorded. Because of this, you should typically import your Account data first, creating the records 
complete with address and telephone information (plus perhaps Account Type and lots of other 
information, depending on your old CRM system). This avoids creating rather empty Account 
records, and having to manually add the rest of their information later. 
 
See the sections below for exact steps on exporting and importing Contacts and Accounts. 
 

Export Contacts from Your Current Contact Manager…  
We will use Outlook 2003 as an example of exporting contact manager data. Other systems tend to 
work in similar ways. 

1. Under the File menu, select Import and Export. The Import and Export Wizard dialog box is 
then displayed.  

2. Select the action Export to a file, and click the Next button. 

3. Choose to create a file of the type Comma Separated Values (Windows), and click on the 
Next button. 
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4. Select an Outlook folder from which to export – typically your contacts folder - and click the 
Next button. 

5. Enter the filename and directory location for the exported file to be created, and click the 
Next button. 

6. Confirm your intention to export this file by clicking on the Finish button.  

7. The desired .CSV file is then created by Outlook 2003. You can view the file easily, using 
Microsoft Excel or a simple text editor, to confirm that the data you intended has been 
exported. 

 

Import Accounts…  
If your Account data is coming in from another CRM system, then typically that system understands 
the distinction between a Contact and an Account – that one Account can have multiple Contacts – 
and has separate data for each. If, however, your data is being imported from a simpler contact 
manager – such as Microsoft Outlook, then the only data available is Contact data, and you will have 
to be a bit creative to avoid a lot of manual data entry as described above.  

If you are importing Account data from a full CRM, proceed now to step 5. If you only have exported 
contact data, and need to massage it to act as Account data to be imported, perform steps 1-4 
below: 

1. Copy your exported Contacts.csv file, and call the copy Accounts.csv. 

2. Edit the Accounts.csv file using Excel. First, sort the file on the column which contains the 
Company name.  

3. Now the more complex part: As you scroll through your data, sorted by Company name, you 
will see successive records which have the same company name, because there is more 
than one Contact from that Account (in Sugar Suite terminology!). To avoid multiple copies of 
the same Account within Sugar Open Source, you need to delete these duplicates. And to 
make sure that the best information is attached to the Account record, you should retain only 
the contact whose address and telephone information best represents the Account as a 
whole.  

Also look out for Company names which are similar but not identical due to inconsistencies 
in the way the Company name was entered – you should delete all duplicate records except 
the one with the Company name spelt exactly as you wish to see it in Sugar Open Source. 

4. Now that you have a nice clean set of Account data, save the Excel file as a .CSV file type, 
and let’s proceed to import this Account data. 

5. Click on the import Accounts function within the Navigation Shortcuts Box of the Accounts 
module. 

6. Specify the Data Source: Select Salesforce.com, ACT!, or Custom – then click on the Next 
button to continue. For ‘massaged’ Outlook files where the field names no longer match 
exactly what is exported from Outlook, use the Custom data source. 

7. Upload the Export File: Use the Browse button to locate the Accounts CSV data file, and 
then click on the Next button to continue. 

8. Confirm Fields and Import: This screen (see Figure 28 below) shows four columns of data. 
Column 2 (Header Row) is the key – this contains the names of the fields being exported 
from your old CRM or contact manager. Columns 3 and 4 show example data from the first 
two records you are about to import. Column 1 (Database Field) is where you come in – you 
need to use all of the drop-down box controls in this column to select the fields within Sugar 
Open Source into which each incoming Account field is imported.  
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Spend some time with this, exploring the names of the incoming fields, and the names of the 
corresponding Sugar Open Source fields, until you are sure you have defined the optimum 
mapping between them. If you are importing from Outlook, a particularly important field 
mapping to get right is to map the incoming Company field to the Account Name field within 
Sugar Open Source.  

9. When you are satisfied you have the field mapping right, click on the Import Now button, at 
the bottom right of the screen. Before you do this you may choose to click on the Save As 
Custom Mapping checkbox, and provide a name for this mapping so that it may be used 
again in future. 

10. The Import Results screen is displayed. It will summarize how many records were 
successfully imported, how many were skipped over, and the reasons they were skipped 
over.  Below the summary are complete lists of all the data imported.  

11. You can now choose to click on the Undo Last Import, Import More, or Finished buttons. 
Click on the Finished button if you are satisfied with the results of the data import, or Undo 
Last Import if you want to go back and try again – usually to improve the field mapping.  

 

 
Figure 21: Confirm Fields and Import Screen 

 

Import Contacts…  
Now that you have a set of Account records with fully descriptive data, let’s import your Contact data: 

1. Click on the import Contacts function within the Navigation Shortcuts Box of the Contacts 
module. 

2. Specify the Data Source: Select Salesforce.com, Microsoft Outlook, ACT!, or Custom – then 
click on the Next button to continue. 

3. Upload the Export File: Use the Browse button to locate the data file exported by your 
contacts manager, and then click on the Next button to continue. 
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4. Confirm Fields and Import: This screen (see Figure 28 above) shows four columns of data. 
Column 2 (Header Row) is the key – this contains the names of the fields being exported 
from your old CRM or contact manager. Columns 3 and 4 show example data from the first 
two records you are about to import. Column 1 (Database Field) is where you come in – you 
need to use all of the drop-down box controls in this column to select the fields within Sugar 
Open Source into which each incoming Contact field is imported.  

Spend some time with this, exploring the names of the incoming fields, and the names of the 
corresponding Sugar Open Source fields, until you are sure you have defined the optimum 
mapping between them. If you are importing from Outlook, a particularly important field 
mapping to get right is to map the incoming Company field to the Account Name field within 
Sugar Open Source, so that Contacts are associated with the correct Accounts.  

5. When you are satisfied you have the field mapping right, click on the Import Now button, at 
the bottom right of the screen. Before you do you may choose to click on the Save As 
Custom Mapping checkbox, and provide a name for this mapping so that it may be used 
again in future. 

6. The Import Results screen is displayed. It will summarize how many records were 
successfully imported, how many were skipped over, and the reasons they were skipped 
over.  Below the summary are complete lists of all the data imported – both Contacts, and 
any Accounts which were automatically created.  

7. You can now choose to click on the Undo Last Import, Import More, or Finished buttons. 
Click on the Finished button if you are satisfied with the results of the data import, or Undo 
Last Import if you want to go back and try again – usually to improve the field mapping.  

 

6.2  Importing Leads & Opportunities 
 
Leads and Opportunities are typically only tracked by a full CRM system, not a simple contact 
manager. If your old system is Microsoft Outlook or a similar contact manager, then you will have no 
data to import. If you are migrating from a full CRM system such as Salesforce.com, then the Lead 
and Opportunity data may be exported from that system and imported into Sugar Open Source in a 
very similar fashion to importing Contact data, as described above.  
 

6.3  Exporting Information 
 
Sugar Open Source has quite flexible data exporting capabilities. Essentially all of the Sugar Open 
Source modules have an export function, accessed by clicking on the Export link in the top left corner 
of the list portion of each list view screen, including all five types of Activities, Accounts, Contacts, 
Leads, Opportunities and Cases. 
 
In each case, a Comma Separated Values (.CSV) file is produced, which contains all the currently 
selected records from the module in use (not just those records currently displayed on the screen). 
CSV files can be opened by Microsoft Excel for viewing, or by Notepad, Wordpad, and other text 
editors – and can easily be parsed as input files by most software. 
 
A sample portion of a CSV file, exported from the Accounts module and viewed in Excel, is shown in 
Figure 29 below. You can see that essentially the entire database table of information is exported in 
the CSV file with column titles, including the Record ID (a long and largely incomprehensible string of 
letters and numbers used as a unique reference to each Account record) and other fields which 
Sugar Open Source uses internally.  
 



Sugar Open Source User Guide 
 

 
Section 6: Information Import and Export         Page 43 

 

Figure 22: CSV File in Excel 
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